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Figure 1.1  Typical PROFIBUS link using a PLC as master
(from section 3.3 of http://www.profibus.com)

PROFIBUS USER GUIDE

1.  INTRODUCTION
PROFIBUS DP is an industry standard open network used to interconnect instrumentation
and control devices in, for example,  a manufacturing or processing plant.  It is often used
to allow a central Programmable Logic Controller (PLC) or PC based control system to
use external ‘slave’ devices for input/output (I/O) or specialised functions, thus reducing
the processing load on the controlling unit so that its other functions can be carried out
more efficiently using less memory.

The PROFIBUS network uses a high speed version of the RS485 standard, and permits
transmission rates of up to 12MBaud between the host and up to 32 PROFIBUS ‘Stations’
otherwise called ‘nodes’ within a single section of network.  The use of RS485 repeaters
(each counted as a node) allows the maximum of 127 nodes (addresses 0 to 126) to be
supported.

It is not within the scope of this document to describe the PROFIBUS standard in detail,
nor does it discuss the Process Controller itself.  More detailed information on the PROFI-
BUS can be found by reference to ‘http//www.profibus.com’, and details of the Process
Controller are to be found in the Reference Manual/User guide (Part 1 of this manual).

1.1  GSD Files
Figure 1.1 shows that for each instrument on the communications link, a Device Database
File is constructed and loaded into the profibus configuration terminal.  These files (called
Gerätestammdaten or GSD files) contain information, relating to the instrument’s param-
eters, which the PROFIBUS master (a PLC in the figure) needs in order to communicate
with the device.

A number of ‘default’ GSD files, and editing software are included on the support disk,
supplied with this manual.  More details are to be found in Appendix A below.

Field
device

I/O Sensor
Motor
drive

Trans-
mitter

Field
device

Device database files (GSD files)
PROFIBUS DP

PLC

Profibus
configuration
terminal

System configuration
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Figure 2.1b  Communications wiring and termination

§2.1
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Figure 2.1a  Communications Pinout

2.  INSTALLATION
PROFIBUS DP is provided by means of an option configuration board which can be fitted
to instruments with firmware levels V2 or higher.  No special software configuration is re-
quired.

2.1  Wiring
The wiring to the PROFIBUS option board is termi-
nated at slot 2, which is the left-most slot when the
instrument is viewed from the rear.  Figure 2.1a
shows the pinout, and figure 2.1b the termination, bi-
assing and shielding arrangement.
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2.1 WIRING (Cont.)

2.1.1  Earthing the shield
The PROFIBUS standard suggests that both ends of the transmission line be connected to
safety earth.  If such a course is followed, care must be taken to ensure that differences in
local earth potential do not allow circulating currents to flow, as these can not only induce
large common mode signals in the data lines, resulting in communications failure, but can
also produce potentially dangerous heating in the cable. Where doubt exists, it is recom-
mended that the shield be earthed at only one point in each section of the network.

2.1.2  Network wiring.
There are two distinct ways of wiring a network, known as ‘Linear topology’ and ‘Tree
topology’.  In a linear network (figure 2.2.1a),  the maximum number of repeaters is three,
giving a total number of stations of 122.  In theory the tree set-up (figure 2.2.1b) can have
more stations, but the PROFIBUS protocol limits the number of stations (including re-
peaters) to 127 (addresses 0 to 126).  It is up to the user to determine which is the most
cost effective way of organising the layout.

Figure 2.1.2a  Typical linear bus layout
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A maximum of three repeaters is allowed, bringing the maximum number of nodes to 122.

§2.1.2
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Figure 2.2  Accessing 'AD'
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Impedance ................. 135 to 165 ohms at 3 to 20 MHz
Resistance ................. <110 Ohms/km
Cable capacitance ..... <30 pF/metre
Core diameter ........... 0.34mm2 max. (22 awg)
Cable type ................. Twisted pair, 1x1, 2x2 or 4x1 lines
Signal attenuation ..... 9dB max. over total length of line section
Shielding ................... Cu shielding braid, or shielding braid and shielding foil

Line length/segment (metres) 100 200 400 1000 1200

Max Baud rate (kbit/sec) (kB) 12,000 1,500 500 187.5 93.75

 Table 2.1.4  Maximum baud rate versus line length

2.1.3  Cable type
Table  2.1.3 below gives the specification for a suitable cable such as Beldon B3079A.

Table 2.1.3  Cable specification

2.1.4  Maximum Baud rate compared with line length
The maximum transmission speed depends on the length of the cable run including ‘stub’
(distance from the bus to a station) lengths.  Guaranteed minimum values are given below.

2.2  Node Address
Each node must be given a unique address,  and
this is done in instrument configuration, by ac-
cessing parameter list 4, parameter ‘AD’. Once
the address has been set up, the unit should be
powered off, then on again.

The unit has an address of 254 set at the factory.
This is outside the address range of the PROFI-
BUS protocol (0 to 126),  so if the unit is
inadvertantly inserted into the network without
a new address having been set, the bus will not
be affected.

Figure 2.2 shows how to access the parameter
lists, assuming that the user knows the pass-
word.  For fuller details of parameter access, see
Chapter three of Part 1 of this manual.

Note: To access the comms. status word
‘CS’ (sections 2.3.1 and 2.4.1) operate the
up arrow key twice from the password
(‘P’‘O’) display.
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§2.4

2.3 Adding the unit to the network
Once the unit has been physically wired, and has had an address allocated, a GSD file
must be imported into the network configuration software.  A number of GSD files are
provided on the PROFIBUS support disc, along with a software program called
'PROFCONF' which allows the user to edit these GSD files and/or to create new ones.
See Appendix A for details.

The unit can now be added to the network, using the network configuration software, and
I/O data areas can be assigned in the master unit, to represent it.

Once the network is defined, the configuration is written to the master, as described in the
network configuration software documentation, and the network can be started.  If all is
well, the communications. status word ‘CS’ in list 4 will be displayed as ‘0003’*.  Values
can now be assigned to PROFIBUS outputs and PROFIBUS inputs can be read as re-
quired.

To view CS, use the up arrow key after P0 (ref figure 2.2).

Note:
CS = 0000 means that there is no PROFIBUS card installed or, the card has not

been recognised.
CS = 0002 means that the card is installed but it has not been configured by a

PROFIBUS Master.

2.4  Trouble-shooting

WARNING
Fault finding may affect the network and control system.  Ensure that no damage
to personnel or equipment can be caused by any fault finding activity.

2.4.1  No communications
1. Check wiring, verifying the continuity of A and B connections to the master, and en-

sure that the correct terminals have been used.  Figure 2.1a above, shows the termina-
tions for this unit.

2. Check the node address, as described in section 2.2 above.  Ensure the address is
unique.

3. Verify that a PROFIBUS comms. module is fitted.  This can be done by inspecting the
underside of the circuit board for the legend ‘PROFIBUS comms’.

4. Check the communications status word (CS) as described in section 2.2.
CS = 0000 means either that  no card is installed, or that it has not been recognised
CS = 0002 means that a PROFIBUS card is installed but it has not been configured by

aPROFIBUS master
CS =  0003 means that a PROFIBUS card has been installed and it has been config-

ured by a PROFIBUS Master.
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§2.4.4

2.4.1  No communications (Cont.)
5. Ensure that the network has been correctly configured and that the configuration has

been correctly downloaded to the master.
6. Verify that the GSD file being used is correct, by loading it into the GSD file

configurator to check the format..
7. Ensure that the maximum line length of transmission line has not been exceeded for

the Baud rate in use (Table 2.1.4 above).
8. Ensure that the final node on the transmission line (no matter what type of instrument

it is) is terminated correctly using three resistors as shown in figure 2.1b above,  and
that only the first and final nodes are so terminated.  Note that some equipment has
built-in pull up and pull down resistors which in some cases can be switched in and
out of circuit.  Such resistors must be removed or switched out of circuit for all but the
instruments at each end of the line.

9. Replace any faulty item(s) and re-test.

2.4.2  Intermittent failure to communicate
This fault is shown by the diagnostic status changing, withoutalarms being generated in
the instrument.  Section 2.5 below, shows the diagnostics information.

1. Check wiring as in 2.4.1 above. Pay particular attention to the integrity of the screen-
ing and termination

2. Check the number of words in the data exchange against the maximum number the
master can support.

3. Ensure that the maximum line length of transmission line has not been exceeded for
the Baud rate in use (Table 2.1.4 above).

4. Ensure that the final node on the transmission line (no matter what type of instrument
it is) is terminated correctly using three resistors as shown in figure 2.1b above,  and
that only the first and final nodes are so terminated.  Note that some equipment has
built-in pull up and pull down resistors which in some cases can be switched in and
out of circuit.  Such resistors must be removed or switched out of circuit for all but the
instruments at each end of the line.

5. Replace any faulty item(s) and re-test.

2.4.3  Parameter ‘jammed’ at one value and cannot be altered from
the front panel

PROFIBUS DP writes all output data continuously, so that if Output power,  Setpoint, or
Auto/Manual status etc. are included in the output data,  their settings are stored in the
master data registers will override any setting entered from the front panel.  To avoid this
happening, use ‘Demand data’ to write parameter values, ONLY when changes are re-
quired.

2.4.4  Data format or parameter data seems incorrect
Verify that the GSD file is correct for the given application by loading it into the GSD file
configurator program.
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2.5  Diagnostic information
PROFIBUS DP provides a message giving diagnostic information for each slave unit.
The process controller uses the ExtDiagData area of this message (bytes 7 and 8) to send a
word containing 16 bits of information relating to the alarm status of the controller as
shown in table 2.5 below.  A ‘new diagnostics’ event occurs whenever any of the moni-
tored events changes state.

Bit Description
0 High absolute (loop 1)
1 Low absolute (loop 1)
2 High deviation (loop 1)
3 Low deviation (loop 1)
4 Unacknowledged high absolute (loop 1)
5 Unacknowledged low absolute (loop 1)
6 Unacknowledged high deviation (loop 1)
7 Unacknowledged low deviation (loop 1)
8 High absolute (loop 2)
9 Low absolute (loop 2)

10 High deviation (loop 2)
11 Low deviation (loop 2)
12 Unacknowledged high absolute (loop 2)
13 Unacknowledged low absolute (loop 2)
14 Unacknowledged high deviation (loop 2)
15 Unacknowledged low deviation (loop 2)

Table 2.5  Controller alarm status

2.6  Global commands
Freeze and Sync from a PROFIBUS master have no effect

§2.6
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3.  OPERATION
PROFIBUS DP performs a cyclical scan of the network devices, during which input and
output data for each node is exchanged.

Values from each node (input data) are read by the controller, which then runs its control
program, and generates a set of values (output data) to be transmitted to the nodes.   This
process is called an ‘I/O data exchange’. This process is repeated continuously, to give a
cyclical I/O data exchange.

Examples of input data are

a. A set of digital readings for a digital input
b. The measured temperature and alarm status from a PID controller.

Examples of output data are:

a. A setpoint to be sent to a PID controller
The I/O data exchange can be repeated continuously, can be synchronised at given times,
or can be repeated at a pre-defined interval, which is asynchronous with the controller.
Each node is normally assigned a group of PLC I/O registers, or a single function block,
so that the controlling program can deal with each node’s data as though the node is an in-
ternal device, without having to be concerned about timing problems.  This mapping of
node to register or function block is carried out during  network configuration, which is
usually carried out using a PC based program.

3.1  I/O data transfer limits.
The PROFIBUS DP standard allows up to 234 bytes of data to be transferred in each di-
rection, during each I/O data exchange.  Many PLC masters, however, are unable to sup-
port more than 32 bytes, and this has become a typical value.  Input and output data
lengths for a given node are variable, and it is possible to define nodes as read only, write
only or read/write.

The I/O data mixture used by a given slave device is defined by what is called a ‘GSD’
file, which can be edited to change the mapping of node parameters to PROFIBUS inputs
and outputs.  This file is imported into the network configuration before the network is
created.

3.2.  Data format
Data is transmitted in both directions as a single 16-bit integer value (also called a ‘regis-
ter’).  The value is returned as a scaled integer such that 999.9 is returned as 9999, and
1.234 is returned as 1234.  The control program in the PROFIBUS master must convert
these integers into floating point numbers if required.

§3.2
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4. SPECIFICATION
This information is additional to, or replaces the relevant parts of the specification given in
Part 1 of this manual.  For cable specification and Baud rate versus cable length, see sec-
tion 2.1

Safety isolation
 Isolation  (BS EN61010 dc to 65 Hz) Installation category II, Pollution degree 2†

Any terminal to safety earth: 50V dc or RMS (double isolation)

Vp and C/C’ limitations*
Maximum current source/sink 30mA (5 Volts)

† Installation category II:The rated impulse voltage for equipment on nominal 230Volts
is 2500 V.

Pollution category 2: Normally, only non-conductive pollution occurs.  Occasion-
ally, however, a temporary conductivity caused by condensation shall be expected.

* Vp and C/C’ may be used ONLY as pull up/down facilities for terminating networks
as shown in section 2.1 above

§4
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Appendix A §A1

Appendix A GSD FILES

A1 THE GSD FILE CONFIGURATOR

A1.1  Introduction
The GSD file configuration software (PROFCONF) is supplied on the PROFIBUS sup-
port disc, and provides a simple means of setting up PROFIBUS input and output data
frames.  It is a 16-bit Windows application which will run on Windows 3.1, Windows 95
and Windows NT.

A1.2  Installation
Place the PROFIBUS support disc in the disc drive, and run A:\SETUP.EXE from Pro-
gram Manager or Windows Explorer.  Follow the on-screen prompts.  Several sample
GSD files  supplied on the same disc are loaded into the ‘installation’ directory.  These
files are described in section A2 below.

A1.3  Operation
The screen layout is as depicted in figure A1.3 below.  Initially, if the mouse cursor is
moved to an area and left there, a ‘hint’ box appears to explain what that area of screen
does.  (Hints can be disabled from the ‘Help’ menu when they are no longer needed.)

Put simply, the operation of the window is as follows:

1. Select instrument type from the icons at the left edge of the screen.
2. Add device parameters to the PROFIBUS Inputs or PROFIBUS Outputs area.
3. Use  ‘Save’ in order to edit an existing GSD file or ‘Save As’ to create a new file.
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A1.3  OPERATION (Cont.)

A1.3.1  Editing the I/O areas
This can be done in two ways:
a. Display the required parameter in the Device Parameter area, using the ‘Tabs’ at the

bottom of the area if necessary, then click-and-drag the required parameter to the
PROFIBUS inputs or PROFIBUS Outputs areas as appropriate.

b. Display the required parameter in the Device Parameter area, using the ‘Tabs’ at the
bottom of the area if necessary, then double-click on the parameter to move it to
whichever of the Inputs or Outputs area is active.  (Selected by clicking on the associ-
ated arrow key.

A parameter can be moved within the list, by click-dragging it within the area.

A parameter can be removed from the Inputs/Outputs list by
a. Clicking on the parameter to highlight it, then clicking the ‘Delete’ key to the right of

the relevant area.
b. Pressing the right mouse button whilst the cursor is over the parameter name.  Confir-

mation of the removal is requested by a pop-up box.
The entire list can be removed using the ‘Clear’ key.

Figure A 1.3  typical GSD File window
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L1 Loop1

Decimal Point Position
Setpoint High Range
Setpoint Low Range
Trim High Range/Limit
Trim Low Range Limit
Setpoint High Limit
Setpoint Low Limit
High Absolute Alarm
Low Absolute Alarm
High Deviation Alarm
Low Deviation Alarm
High Output Limit
Low OutPut Limit
Proportional Band

 Device Parameters

L2 Loop2

Use Demand Data

GSD File Cus tom is ation Tool (E1.02)
File Help

Profibus Inputs

Delete

Clear

Profibus Outputs

Delete

Clear

Number of Input Words   0

Number of Output Words   0

Description Cascade/Override

R A M

PAR SP

Integral Time
Derivative Time
Trim Value

Click on unit
type to be

configured.

Unit icon is
then

highlighted

Tabs

Unit description
entered here

Click here to invoke
'demand data'

Use these arrow keys
to access 'hidden' tabs

Icons mean
(left to right)
Save file
Open file
Save to disc
Print window
Print I/O usage
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A1.3.1  EDITING THE I/O AREAS (Cont.)
A maximum of 117 words (input and/or output) including the requirements for demand
data (Appendix B) is imposed by the configurator.  When this limit is reached, parameters
must be removed from lists before any further ones can be added.  Because many PLCs
cannot support more than 32 words of data at a time, it is recommended that 32 be treated
as the limit.

The ‘View I/O map’ item in the File menu displays a summary of the I/O memory map for
the current GSD file.  This may be pasted to the clipboard for later use, and can be printed
from the File menu.

A1.3.2  Using the file
Before saving the file, it is recommended that a meaningful description in entered in the
area at the bottom of the page.  Finally, support for demand data can be enabled by click-
ing in the ‘Use Demand Data’ box.  Demand data is discussed in Appendix B to this
manual.

Once the Input/Output lists are as required, the file should be saved to disc.  The file can
now be imported into the PROFIBUS network configuration tool, and used as an applica-
tion program.

Note:  Several different GSD files can be created for the same instrument, thus al-
lowing the user to create a library of different applications.

A1.4  Example
This example shows how to set up a GSD file to allow gain scheduling using PID settings
stored in a PLC.

Input data Process variable
Output data Proportional band

Integral time
Derivative time
Cutback high
Cutback low

In such an application, the PLC monitors the ‘Process Variable (e.g. temperature), and
when its value passes into a particular pre-set band, the PLC sets the control parameters
from previously determined settings.

Appendix A §A1.4
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EURO6300.GSD (Manual station)  L1 (loop 1) parameters

 0 Process variable (L1) 1 PV
 1 Resolved Setpoint (L1) 5 SP

Word
number Description Tag

number
Mne-
monic

Input data

Word
number Description Tag

number
Mne-
monic

Input data length (words): 2
Output data length (words): 1

Output data

 0 Local Setpoint (L1) 2 SL

EURO630S.GSD (Single loop controller)  L1 (loop 1) parameters

 0 Decimal Point Pos (L1) 0 DP
 1 Process variable (L1) 1 PV
 2 Control Output (L1) 3 OP
 3 Alarm Status Word (L1) 4 AL
 4 Resolved setpoint (L1) 5 SP
 5 Resolved Mode (L1) 9 MN

Word
number Description Tag

number
Mne-
monic

Input data

 0 Local Setpoint (L1) 2 SL
 1 Control Output (L1) 3 OP
 2 Mode Request (L1) 8 MS

Word
number

Tag
number

Mne-
monic

Output data

Input data length (words): 6
Output data length (words): 3

Appendix A  §A2.2

A2  SAMPLE GSD FILES
This section contains input and output data details for the sample GSD files supplied on
the support disc. These files could be used unchanged, but will normally be edited by the
user to suit the application.

The PROFIBUS tag number and mnemonic can be found in tables C3.1 and C3.2 in Ap-
pendix C below.

A2.1  Basic GSD file EURO6300.GSD

A2.2  Single loop controller GSD file: EURO630S.GSD
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A2.3  Cascade controller GSD file: EURO630C.GSD

A2.4  Ratio controller GSD file: EURO630R.GSD

EURO630R.GSD (Ratio controller)  L1 & 2 (loops 1 & 2) parameters

 0 Decimal Point Pos (L1) 0 DP
 1 Process variable (L1) 1 PV
 2 Control Output (L1) 3 OP
 3 Alarm Status Word (L1) 4 AL
 4 Resolved setpoint (L1) 5 SP
 5 Resolved Mode (L1) 9 MN
 6 PV2 Decimal Point (Ratio) 96 DP
 7 PV2 Value (Ratio) 97 PV
 8 Ratio Decimal Point (Ratio) 104 DP_R
 9 Measured ratio (Ratio) 100 MR

Word
number Description Tag

number
Mne-
monic

Input data

 0 Local Setpoint (L1) 2 SL
 1 Control Output (L1) 3 OP
 2 Mode Request (L1) 8 MS
 3 Ratio setpoint (Ratio) 101 RS

Word
number

Tag
number

Mne-
monic

Output data

Input data length (words): 10
Output data length (words): 4

Appendix A §A2.4

EURO630C.GSD (Cascade/Override controller)  L1 & 2 (loops 1 & 2) parameters

 0 Decimal Point Pos (L1) 0 DP
 1 Process variable (L1) 1 PV
 2 Control Output (L1) 3 OP
 3 Alarm Status Word (L1) 4 AL
 4 Resolved setpoint (L1) 5 SP
 5 Resolved Mode (L1) 9 MN
 6 Decimal Point Pos (L2) 48 DP
 7 Process variable (L2) 49 PV
 8 Control Output (L2) 51 OP
 9 Alarm Status Word (L2) 52 AL
 10 Resolved Mode (L2) 53 SP

Word
number Description Tag

number
Mne-
monic

Input data

 0 Local Setpoint (L1) 2 SL
 1 Control Output (L1) 3 OP
 2 Mode Request (L1) 8 MS
 3 Local Setpoint (L2) 50 SL
 4 Control Output (L2) 51 OP
 5 Mode Request (L2) 56 MS

Word
number

Tag
number

Mne-
monic

Output data

Input data length (words): 11
Output data length (words): 6
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A2.5  Manual station GSD file: EURO630M.GSD

EURO630M.GSD (Manual station)  L1 (loop 1) parameters

 0 Decimal Point Pos (L1) 0 DP
 1 Process variable (L1) 1 PV
 2 Control Output (L1) 3 OP
 3 Alarm Status Word (L1) 4 AL
 4 Resolved Mode (L1) 9 MN

Word
number Description Tag

number
Mne-
monic

Input data

 0 Control Output (L1) 3 OP
 1 Mode Request (L1) 8 MS

Word
number Description Tag

number
Mne-
monic

Output data

Input data length (words): 5
Output data length (words): 2

Appendix A  §A2.5
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Appendix B §B1

Appendix B DEMAND DATA

B1  OVERVIEW
The Demand data sub-protocol is supported via standard software in many PLCs.  It can
also be implemented in ladder logic.  The protocol uses the first eight bytes in the request
and response messages of the cyclic I/O data exchange described in section 3 of this
manual, and is enabled by setting the first byte of the module configuration data to hex 73.
Once enabled, it allows random read/write access to any parameter within the instrument.

Setting the value to hex 73 can be done by clicking the ‘Use demand data’ box in the GSD
file configuration program (also supplied on the disc).

Demand data identifies parameters by ‘tags’, which are unique 16-bit numbers.  For ex-
ample, CONTROL OUTPUT is identified as Tag 3.  The tag for any particular parameter
can be determined by using the right mouse button when the cursor is over the relevant
parameter in the ‘Device Parameters’ area of the configurator program, or by reference to
the tables in Appendix C.

The first four words of the Output data are used to encode a ‘request message’.  The con-
trol program is responsible for writing values to this area to make requests.

As can be seen from the figure above, Word 1 contains the ‘Tag’ of the required parameter
(see Appendix C for a full list) and a read or write request command.  If a read request is
made, bit 12 is set, adding 4096 to the tag value.  Thus to read tag 71, word 1 would have
to have the value 4096 + 71 = 4167.  If a write request is made on parameter 71, word 1
would have the value 8192 + 71 = 8263.

Notes:
1 Bit 11 is always 0
2 The ‘Extended Tag’ word is used for those instruments whose tag numbers can

exceed 2047

Word 1 Word 2 Word 3 Word 4

Byte 0 Byte 1 Byte 2 Byte 3 Byte 4 Byte 5 Byte 7Byte 6

Extended tag Reserved Value or error code

15 9 8 7 6 5 4 3 2 1 01413 1211 10

TagComm-
and

0000 = No command
0001 = Read request (Bit 12 set = 4096)
0010 = Write request (Bit 13 set = 8192)

15 9 8 7 6 5 4 3 2 1 01413 1211 10 15 9 8 7 6 5 4 3 2 1 014 1312 1110 15 9 8 7 6 5 4 3 2 1 014 1312 1110
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B1  OVERVIEW (Cont.)

The first four words of Input data are used by the instrument as a ‘response message’ to
return values and indicate the success or failure of the requested operation.  In this case,
the command field will be either 1 (bit 12 set) (read/write successful) or 7 (bits 12,13,14
set) (read/write unsuccessful).  The Value field will contain the read/written value (if suc-
cessful) or an error code (if unsuccessful). The command field has the value 0 when ac-
knowledging ‘No Command’.

Error codes are:
0 Invalid tag number.
1 Attempt to write to a read-only parameter.
2 Value is out of range.
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Word 1 Word 2 Word 3 Word 4

Byte 0 Byte 1 Byte 2 Byte 3 Byte 4 Byte 5 Byte 7Byte 6

0 0 Anything Anything Anything

Appendix B §B2.1.3

Word 1 Word 2 Word 3 Word 4

Byte 0 Byte 1 Byte 2 Byte 3 Byte 4 Byte 5 Byte 7Byte 6

00010000 00010111 Anything Anything Anything

4119

Word 1 Word 2 Word 3 Word 4

Byte 0 Byte 1 Byte 2 Byte 3 Byte 4 Byte 5 Byte 7Byte 6

00100000 00010111 Anything Anything
Mode status word OR
00010000 00000000

8215

B2  Example

B2.1  Starting an Autotune
An Autotune is a good example of an operation that might be performed using the demand
data sub-protocol, since it is a relatively infrequent operation and it would be wasteful to
dedicate PROFIBUS I/O for such a purpose. From the tag list in Appendix C below, it can
be seen that the Autotune for loop 1 is triggered by setting bit 12 of  Mode Status word
(SM - tag 23) high (true).

B2.1.1  Clear any previous demand data requests
This is done by setting tag and command data to 0 (zero), and waiting for the (identical)
response message.

B2.1.2  Read the value of SM
This is done by setting the value of word 1 to 4096 + 23 = 4119 (section B1 above)

Wait for the response message.  If successful, the command area will have the value ‘1’
(bit 12 set = 4096), so a value of anything other than ‘4119’ in word 1 indicates an error.

B2.1.3  Set Bit 12 of SM
This is done by setting the value of word 1 to 8192 + 23 = 8215 for the write request, and
ORing 4096 with the value of SM to set bit 12.
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Word 1 Word 2 Word 3 Word 4

Byte 0 Byte 1 Byte 2 Byte 3 Byte 4 Byte 5 Byte 7Byte 6

00010000 00010111 Anything Anything Anything

4119

Word 1 Word 2 Word 3 Word 4

Byte 0 Byte 1 Byte 2 Byte 3 Byte 4 Byte 5 Byte 7Byte 6

01110000 00010111 Anything Anything Error code

28695

B2.1.3 SET BIT 12 OF SM (Cont.)

The response will be either the following, if successful...

or the following, if an error has occurred.  Note that bits 12, 13 and 14 of the command
field are set if an error has occurred.

B2.1.4  Re-read SM
A read request on the parameter SM should now be carried out and the value monitored
until bit 12 clears, indicating that the self tune has been successfully completed,  or until
bit 13 becomes set indicating that the self tune has failed.
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Appendix C PARAMETER TABLES

C.1  INTRODUCTION
This Appendix is intended as a reference section to help the user identify the parameter(s)
required, and their associated tag numbers for use with the demand data facility described
in Appendix B.

The section consists of a number of tables as follows:

1. Parameters in alphabetical order
2. List 1 (loop 1) parameters
3. List 2 (loop 2) parameters, including ratio parameters
4. Instrument (list 3) parameters
5. Communications (list 4) parameters
6. Main board I/O configuration (list 5) parameters
7. Expansion board I/O configuration (list 6) parameters
8. I/O calibration parameters (list 7) parameters
9. Incremental control parameters (list 8 and list 1)
10.Diagnostic (list 9) parameters
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C2  LIST OF PARAMETERS AND PROFIBUS TAGS
Tag numbers can be found from table C2 below

Table C2   Alphabetical list of parameters (sheet 1)

Appendix C §C2

Note: List 1 to List 9 parameters are defined in tables C3.1 to C3.9 re-
spectively, below

Absolute alarm - high...........................HA List 1; tag 10 List 2; tag 58
Absolute alarm - Low........................... LA List 1; tag 11 List 2; tag 59
Alarm status word................................ AL List 1; tag 4 List 2; tag 52
Analogue input break protection..........AB List 6; tag 156
Analogue input connections.................AC List 6; tag 157
Analogue input filter time constabt.......AF List 6; tag 164
Analogue input range...........................AR List 6; tag 155
Analogue output connections..............OC List 6; tag 159
Analogue output range........................ OR List 6; tag 158
Backlash compensation....................... BL List 8; tag 236
Baud Rate............................................BD List 4; tag 128
Calibration channel..............................CC List 7; tag 192
Calibration range................................. CR List 7; tag 193
Calibration step....................................ST List 7; tag 194
Calibration value..................................CV List 7; tag 195
Configuration status word.................... SC List 1; tag 21 List 2; tag 69
Control output...................................... OP List 1; tag 3 List 2; tag 51
Controller type..................................... CC List 3; tag 124
Decimal point position..........................DP List 1; tag 0 List 2; tag 48 List 3; tag 96
Derivative time.....................................TD List 1; tag 20 List 2; tag 68
Deviation Alarm - High.........................HD List 1; tag 12 List 2; tag 60
Deviation Alarm - Low..........................LD List 1; tag 13 List 2; tag 61
Digital feedback verify failures.............R3 List 9; tag 202
Digital I/O connection mask.................DC List 6; tag 162
Digital I/O inversion mask.....................DI List 6; tag 161
Digital I/O pull-up type......................... DU List 6; tag 163
Digital I/O values..................................DV List 6; tag 160
Error logs (newest to oldest)........... E0 to EF List 9; tags 204 to 219
Expansion I/O enable...........................B1 List 3; tag 133
Fast status byte....................................FS List 4; tag 120
High absolute alarm.............................HA List 1; tag 10 List 2; tag 58
High deviation alarm............................HD List 1; tag 12 List 2; tag 60
High output limit...................................HO List 1; tag 16
Inertia compensation............................ IN List 8; tag 235
Instrument address..............................AD List 6; tag 157
Instrument identity.................................II List 3; tag 122
Instrument verstion............................... IV List 2; tag 123
Integral time..........................................TI List 1; tag 19 List 2; tag 67
I/O bad readings.................................. R2 List 9; tag 201
I/O missed readings............................. R1 List 9; tag 200
I/O status word..................................... SI List 9; tag 199
Local setpoint.......................................SL List 1; tag 2 List 2; tag 50
Low absolute alarm..............................LA List 1; tag 11 List 2; tag 59
Low deviation alarm............................. LD List 1; tag 13 List 2; tag 61
Low output limit....................................LO List 1; tag 17
Measured ratio.................................... MR List 2; tag 100

Parameter and menmonic List and tag numbers
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C2 LIST OF PARAMETERS (Cont.)

Table C2 (concluded)  Alphabetical list of parameters (sheet 2)

Note: List 1 to List 9 parameters are defined in tables C3.1 to C3.9 re-
spectively, below

Appendix C §C2

Minimum pulse time............................. PT List 1; tag 31
Mode status word................................ SM List 1; tag 23 List 2; tag 71 List 2; tag 105
Motor travel time.................................. TT List 8; tag 230
Output limit - high................................ HO List 1; tag 16
Output limit - low..................................LO List 1; tag 17
Parity....................................................PY List 4; tag 129
Pass code 0......................................... P0 List 3; tag 126
Pass code 1......................................... P1 List 3; tag 127
Process input break protection............. IB List 2; tag 145 List 6; tag 151
Process input connections................... IC List 6; tag 153
Process input filter time constant.......... IF List 2; tag 148 List 6; tag 154
Process input linearisation....................IL List 2; tag 146 List 6; tag 152
Process input range............................. IR List 2; tag 144 List 6; tag 150
Process output range.......................... OR List 4; tag 149
Process variable.................................. PV List 1; tag 1 List 2; tag 49
Proportional band................................ XP List 1; tag 18 List 2; tag 66
Push button mask................................BM List 1; tag 22 List 2; tag 70
Ratio setpoint.......................................RS List 2; tag 101
Ratio setpoint high limit........................HS List 2; tag 102
Ratio setpoint low limit......................... LS List 2; tag 103
Remote setpoint.................................. RM List 1; tag 25 List 2; tag 73
Requested mode................................. MS List 1; tag 8 List 2; tag 56
Resultant mode................................... MN List 1; tag 9 List 2; tag 57
Resultant setpoint................................SP List 1; tag 5 List 2; tag 53
Setpoint high limit................................ HS List 1; tag 14 List 2; tag 62
Setpoint high range............................. HR List 1; tag 6 List 2; tag 54
Setpoint low limit.................................. LS List 1; tag 15 List 2; tag 63
Setpoint low range...............................LR List 1; tag 7 List 2; tag 55
Setpoint - local..................................... SL List 1; tag 2 List 2; tag 50
Setpoint - remote.................................RM List 1; tag 25 List 2; tag 73
Setpoint - resultant...............................SP List 1; tag 5 List 2; tag 53
Strategy cycle time...............................ST List 9; tag 220
Tasks uncompleted..............................R4 List 9; tag 203
Temperature units................................TU List 3; tag 132
Time base............................................ TB List 1; tag 30 List 2; tag 78
Track value.......................................... TK List 1; tag 27
Trim high/range/limit............................HT List 1; tag 28 List 2; tag 76
Trim low range/limit..............................LT List 1; tag 29 List 2; tag 77
Trim value............................................TM List 1; tag 26 List 2; tag 74
Uncontrolled PV...................................PV List 2; tag 97
Uncontrolled PV high range.................HR List 2; tag 98
Uncontrolled PV low range.................. LR List 2; tag 99
Velocity output demand.......................VO List 8; tag 232

Parameter and menmonic List and tag numbers
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C3  PARAMETER LISTS

C3.1  List 1 parameters

Table C3.1  List 1 (Loop 1)  parameters - sheet 1: tags 0 to 20

Appendix C §C3.1

 0 DP Decimal point position for loop 1 parameters (enter 0 to 4) Read/Write
 1 PV Process variable Read only
 2 SL Local setpoint Read/Write
 3 OP Control output (0.00 to 100.00%) Read/Wtite
 4 AL Alarm status word N/A
   Bit 0 High absolute (true = active) Read only
   Bit 1 Low absolute (true = active) Read only
   Bit 2 High deviation (true = active) Read only
   Bit 3 Low absolute (true = active) Read only
   Bit 4 High absolute (true = unacknowledged) Read/Write
   Bit 5 Low absolute (true = unacknowledged) Read/Write
   Bit 6 High deviation (true = unacknowledged) Read/Write
   Bit 7 Low absolute (true = unacknowledged) Read/Write
   Bit 8 Alarm acknowledge (true = resets bits 4 to 7) Write only
   Bit 9 Alarm relay status (true = relay in alarm status) Read only
   Bit 10 Not used
   Bit 11 Not used
   Bit 12 Auto ack. (true = alarm auto acknowlede enabled;  Read/Write
    false = needs manual acknowledge)
   Bit 13 Relay disable (true = disable relay) Read/Write
   Bit 14 Relay only on absolute alarms. Read/Write
    (true = relay operates only for absolute alarms;
    false = relay operates for deviation alarms as well)
   Bit 15 Relay action.  Read/Write
    (true = active only for unacknowledged alarms;
    false = active for any valid alarm.)
 5 SP Resultant setpoint Read only
 6 HR Setpoint high range Read/Write
 7 LR Setpoint low range Read/Write
 8 MS Requested Mode  Read/Write

 9 MN Resultant mode

 10 HA High absolute alarm level Read/Write
 11 LA Low absolute alarm level Read/Write
 12 HD High deviation alarm level Read/Write
 13 LD Low deviation alarm level Read/Write
 14 HS Setpoint high limit Read/Write
 15 LS Setpoint low limit Read/Write
 16 HO High output limit (0.00 to 100.00 %) Read/Write
 17 LO Low output limit (0.00 to 100.00 %) Read/Write
 18 XP Proportional band (0.0 to 1999.9) Read/Write
 19 TI Integral time (0.00 to 199.99 mins/secs) Read/Write
 20 TD Derivative time (0.00 to 199.99 mins/secs) Read/Write

0 = Hold 4 = Ratio
1 = Track 5 = Remote Auto
2 = Manual 6 = Forced manual
3 = Local auto 7 = Forced auto

0 = 'M' button operated
1 = 'A' button operated
2 = 'R' button operated

Tag Mne-
monic

List 1 parameters
Enable

(w.r.t. to host)
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C3.1 LIST 1 PARAMETERS (Cont.)

Table C3.1  List 1 (Loop 1)  parameters - sheet 2: - Tag 21

 21 SC Configuration status word Read/Write

Tag
Mne-
monic

List 1 parameters (Cont.)
Enable

(w.r.t. to host)

Bit 0 POWER UP
 true: power up in 'Manual with fail-safe o/p
 false: power up in last mode and last output
Bit 1 FAIL-SAFE OUTPUT
 true: low output
 false: last output
Bit 2 INVERT O/P
 true: invert electrical output
 false: no inversion
Bit 3 INVERT PID
 true: ∆PV and ∆OP in the same sense
 false: ∆PV and ∆OP in opposite senses
Bit 4 PV FAIL MODE
 true: maintain existing mode on PV failure
 false: adopt Forced Manual Mode with fail-safe o/p on PV failure
Bit 5 INVERSE RATIO
 true: Loop 1 remote setpoint = PV2 x ratio setpoint
 false: Loop 1 remote setpoint = PV2 ÷ ratio setpoint
Bit 6 RATIO TRACK
 true: Ratio setpoint tracks measured setpoint
  (when loop 1 not in remote)
 false: Ratio setpoint does not track measured setpoint.
Bit 7 NOT USED
Bit 8 INCREMENTAL CONTROL
 true: use incremental control
 false: use continuous control
Bit 9 ON/OFF CONTROL
 true: use on/off control
 false: use PID control
Bit 10 NOT USED
Bit 11 SL BALANCE (SL = local setpoint)
 true: De-bump on writing to SL (SE bit 5 set)
 false: Do not de-bump when writing to SL
Bit 12 SL TRACK (SL = local setpoint)
 true: SL tracks PV if the mode is not 'Auto'
 false: SL remains constant
Bit 13 CALIBRATION ENABLE
 true: Enable I/O calibration
 false: Normal operation
Bit 14 PAR TIMOUT ENABLE
 true: parameter display remains until 'R', 'A' or 'M' mode key is operated
 false: display returns to the operator display if no key operations have taken
 place for approximately 5 minutes
Bit 15 RAISE/LOWER SPEED
 true: high speed change of parameter values
 false: normal speed with aceleration feature.

Appendix C §C3.1
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C3.1  LIST 1 PARAMETERS (Cont.)

Table C3.1  List 1 (Loop 1)  parameters - sheet 3: - Tags 22 to 31

Appendix C §C3.1

 22 BM Pushbutton Mask - disables 'R", 'A', 'M' pushbuttons Read/Write
 23 SM Mode status word
   Bit 0 Hold select   Read/Write
   Bit 1  Track select  Read/Write
   Bit 2 Remote enable Read/Write
   Bit 3 Comms disable Read/Write
   Bit 4 NOT (Hold OR Manual) Read only
   Bit 5 NOT (Remote Auto) Read only
   Bit 6 Raise output Read/Write
   Bit 7 Lower output Read/Write
   Bit 8 Sensor break (true = broken) Read only
   Bit 9 Sumcheck error Read/Write
   Bit 10 Calibration sumcheck error Reaf/Write
   Bit 11 Hardware conflict (true = h/w configuration mismatch) Read/Write
   Bit 12 Autotune (true starts one-shot tune) Read/Write
   Bit 13 Tune fail (true = tuning failure) Read only
   Bit 14 Drooptune (true causes manual reset) Read/Write
   Bit 15 Cold started (true on cold start; false on warm start) Read only
 24 SE(1) Control status word for loop 1 Read only
 25 RM Remote setpoint value Read/Write
 26 TM Trim value  Read/Write
 27 TK Track value (0.00 tro 100.00%) Read/Write
 28 HT Trim high range and high limit Read/Write
 29 LT Trim low range and low limit Read/Write
 30 TB Timebase (0 = seconds; 1 = minutes) Read/Write
 31 PT Minimum pulse time (0.1 to 60 seconds) Read/Write

Tag Mne-
monic

List 1 parameters (concluded)
Enable

(w.r.t. to host)
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C3.2  List 2 parameters

Table C3.2  List 2 (Loop 2)  parameters - sheet 1: - Tags 48 to 68

Appendix C §C3.2

 48 DP Decimal point position for loop 2 parameters (enter 0 to 4) Read/Write
 49 PV Process variable Read only
 50 SL Local setpoint Read/Write
 51 OP Control output (0.00 to 100.00%) Read/Wtite
 52 AL Alarm status word N/A
   Bit 0 High absolute (true = active) Read only
   Bit 1 Low absolute (true = active) Read only
   Bit 2 High deviation (true = active) Read only
   Bit 3 Low absolute (true = active) Read only
   Bit 4 High absolute (true = unacknowledged) Read/Write
   Bit 5 Low absolute (true = unacknowledged) Read/Write
   Bit 6 High deviation (true = unacknowledged) Read/Write
   Bit 7 Low absolute (true = unacknowledged) Read/Write
   Bit 8 Alarm acknowledge (true = resets bits 4 to 7) Write only
   Bit 9 Alarm relay status (true = relay in alarm status) Read only
   Bit 10 Not used
   Bit 11 Not used
   Bit 12 Auto ack. (true = alarm auto acknowlede enabled;  Read/Write
    false = needs manual acknowledge)
   Bit 13 Relay disable (true = disable relay) Read/Write
   Bit 14 Relay only on absolute alarms. Read/Write
    (true = relay operates only for absolute alarms;
    false = relay operates for deviation alarms as well)
   Bit 15 Relay action.  Read/Write
    (true = active only for unacknowledged alarms;
    false = active for any valid alarm.)
 53 SP Resultant setpoint Read only
 54 HR Setpoint high range Read/Write
 55 LR Setpoint low range Read/Write
 56 MS Requested Mode  Read/Write

 57 MN Resultant mode

 58 HA High absolute alarm level Read/Write
 59 LA Low absolute alarm level Read/Write
 60 HD High deviation alarm level Read/Write
 61 LD Low deviation alarm level Read/Write
 62 HS Setpoint high limit Read/Write
 63 LS Setpoint low limit Read/Write
 64 m1041 Dummy parameter Read/Write
 65 m1042 Dummy parameter Read/Write
 66 XP Proportional band, On/off control, hysteresis (0.0 to 1999.9) Read/Write
 67 TI Integral time (0.00 to 199.99 mins/secs) (0 disables integral term) Read/Write
 68 TD Derivative time (0.00 to 199.99 mins/secs) (0 disables derivative term) Read/Write

0 = Hold 4 = Ratio
1 = Track 5 = Remote Auto
2 = Manual 6 = Forced manual
3 = Local auto 7 = Forced auto

0 = 'M' button operated
1 = 'A' button operated
2 = 'R' button operated

Tag Mne-
monic

List 2 parameters
Enable

(w.r.t. to host)
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C3.2  LIST 2 PARAMETERS (Cont.)

Table C3.2  List 2 (Loop 2)  parameters - sheet 2:  Tags 69 to 78

Appendix C §C3.2

 69 SC Configuration status word Read/Write
   Bit0 Power up:
    true = power up in 'Manual' with fail-safe o/p
    false = power up in last mode and last output
   Bit 1 Not used
   Bit 2 Not used
   Bit 3 Invert PID
    true = ∆PV and ∆OP in same sense
    false = ∆PV and ∆OP in opposite sense
   Bit 4 Not used
   Bit 5 Not used
   Bit 6 Not used
   Bit 7 Not used
   Bit 8 Not used
   Bit 9 On/Off control
    true = use on/off control
    false = use PID control
   Bit 10 not used
   Bit 11 SL balance (SL = local setpoint)
    true = De-bump on writing to SL (SE bit 5 set)
    false = No de-bump on SL writes
   Bit 12 SL track (SL = local setpoint)
    true = SL tracks PV if mode is not 'Auto'.
    false = SL remains constant
   Bit 13 Not used
   Bit 14 Not used
   Bit 15 Not used
 70 BM Pushbutton Mask - disables 'R", 'A', 'M' pushbuttons Read/Write
 71 SM Mode status word
   Bit 0 Hold select  Read/Write
   Bit 1  Track select Read/Write
   Bit 2 Remote enable Read/Write
   Bit 3 Not used Read/Write
   Bit 4 NOT (Hold OR Manual) Read only
   Bit 5 NOT (Remote Auto) Read only
   Bit 6 Not used Read/Write
   Bit 7 Not used Read/Write
   Bit 8 Sensor break (true = broken) Read only
   Bit 9 Not used Read/Write
   Bit 10 Not used Reaf/Write
   Bit 11 Not used Read/Write
   Bit 12 Autotune (true starts one-shot tune) Read/Write
   Bit 13 Tune fail (true = tuning failure) Read only
   Bit 14 Drooptune (true causes manual reset) Read/Write
   Bit 15 Not used Read only
 72 SE(2) Control status word for loop 1 Read only
 73 RM Remote setpoint value Read/Write
 74 TM Trim value Read/Write
 75 m1052 Dummy parameter Read/Write
 76 HT Trim high range and high limit Read/Write
 77 LT Trim low range and low limit Read/Write
 78 TB Timebase (0 = seconds; 1 = minutes) Read/Write

Tag Mne-
monic

List 2 parameters (Cont.)
Enable

(w.r.t. to host)
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C3.2  LIST 2 PARAMETERS (Cont.)

Table C3.2

List 2 (Loop 2)  parameters - sheet 3 (for Ratio Stations): Tags 96 to 105

Appendix C §C3.2

 96 DP Decimal point position for loop 2 ratio parameters (enter 0 to 4) Read/Write
 97 PV Uncontrolled process variable Read only
 98 HR Uncontrolled PV high range Read/Write
 99 LR Uncontrolled PV low range Read/Write
 100 MR Measured ratio Read only
 101 RS Ratio setpoint Read/Write
 102 HS Ratio setpoint high limit Read/Write
 103 LS Ratio setpoint low limit Read/Write
 104 DP_R Ratio decimal point position for MR, RS, HS, LS Read only
   (For Normal ratio action, DP_R = DP list 2 - DP list 1;
   for inverse ratio action, DP_R = DP list 1 - DP list 2)
 105 SM Mode status word
   Bit 0 Hold select  Read/Write
   Bit 1  Track select Read/Write
   Bit 2 Remote enable Read/Write
   Bit 3 Not used Read/Write
   Bit 4 NOT (Hold OR Manual) Read only
   Bit 5 NOT (Remote Auto) Read only
   Bit 6 Not used Read/Write
   Bit 7 Not used Read/Write
   Bit 8 Sensor break (true = broken) Read only
   Bit 9 Not used Read/Write
   Bit 10 Not used Reaf/Write
   Bit 11 Not used Read/Write
   Bit 12 Autotune (true starts one-shot tune) Read/Write
   Bit 13 Tune fail (true = tuning failure) Read only
   Bit 14 Drooptune (true causes manual reset) Read/Write
   Bit 15 Not used Read only

Tag Mne-
monic

List 2 parameters for ratio stations
Enable

(w.r.t. to host)
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C3.3  List 3 parameters

Table C3.3  List 3 (Instrument) parameters - Tags 124 to 127, 132 and 133

C3.4  List 4 parameters

Table C3.4  List 4 (Communications) parameters - Tags 120, 128, 129, 131

C3.5  List 5 parameters

Table C3.5  List 5 (Main I/O) parameters - Tags 144 to 149

Appendix C §C3.5

 121 m121 Dummy parameter
 122 II nstrument identity (630) Read only
 123 IV Instrument version  Read only
 124 CC Controller type Read/Write

 125 m125 Dummy parameter
 126 P0 Password Nº0 (Access to lists 1 and 2) (0 to 9999) Read/Write
 127 P1 Password Nº1 (Access to all lists) (0 to 9999) Read/Write
 132 TU Temperature Units (0 = ˚C; 1 = ˚F; 2 = Kelvins) Read/Write
 133 B1 Expansion I/O enable (0 = disable; 1 = enable) Read/Write

Tag Mnemonic List 3 parameters
Enable

(w.r.t. to host)

0 = Manual station 3 = Single loop controller with ratio station
1 = Single loop controller 4 = Override controller
2 = Cascade 2-loop controller

 120 FS Fast status byte
 128 BD Baud rate (not used) N/A
 129 PY Parity (nNot used) N/A
 130 CommsRes Communications resolution (always 0) Read only
 131 AD Instrument address (Valid Profibus range: 0 to 126) Read/Write

Tag Mnemonic List 4 parameters
Enable

(w.r.t. to host)

 144 IR Process input range ReadWrite

 145 IB Process input break protection (1 = Upscale, 2 = Downscale) Read/Write
 146 IL Input linearisation

 147 procln_cl Dummy parameter
 148 IF Process input filter time-constant (0 to 1999.9) Read/Write
 149 OR Process output range (0 = 4 to 20 mA; 1 = 0 to 20 mA) Read/Write

Tag Mnemonic List 5 parameters
Enable

(w.r.t. to host)

0 = 4 to 20 mA 3 = 0 to 10 V
1 = 0 to 20 mA 4 = Thermocouple
2 = 1 to 5 V 5 = RTD

0 = none 4 = Type T t/c 7 = Type B t/c
1 = Square root 5 = Type S t/c 8 = Type N t/c
2 = Type J t/c 6 = Type R t/c 9 = Pt100 RTD
3 = Type K t/c

't/c' = thermocouple
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C3.6  Expansion I/O (List 6) parameters

Table C3.6  List 6 (Expansion I/O) parameters - Tags 150 to 164

Appendix C §C3.6

 150 IR Process input range ReadWrite

 151 IB Process input break protection (1 = Upscale, 2 = Downscale) Read/Write
 152 IL Input linearisation

 153 IC Process input connection assignment Read/Write

 154 IF Process input filter time-constant (0 to 1999.9) Read/Write
 155 AR Analogue input range (0, 1 not used; 2 = 1 to 5V; 3 = 1 to 10 V) Read/Write
 156 AB Analogue input break protection Read/Write

 157 AC Analogue input connection assignment Read/Write

 158 OR Analogue output range (0, 1 not used; 2 = 1 to 5 V; 3 = 1 to 10V) Read/Write
 159 OC Analogue output connection assignment Read/Write

 160 DV Digital I/O values at user terminal Read/Write
 161 DI Digital I/O inversion mask Read/Write
 162 DC Digital I/O connection mask Read/Write
 163 DU Digital I/O pullup type Read/Write

 164 AF Analogue input filter time-constant (0 to 1999.9 secs.) Read/Write

0 = Freeze  input
1 = Upscale
2 = Downscale

Tag
Mne-
monic

List 6 parameters
Enable

(w.r.t. to host)

0 = Loop 1 normalised process variable (PV) %
1 = Loop 1 normalised setpoint (SP) %
2 = Loop 1 Control output (OP) %
3 = Loop 2 normalised process variable (PV) %
4 = Loop 2 normalised setpoint (SP) % (only cascade controllers)

0 = 4 to 20 mA 3 = 0 to 10 V
1 = 0 to 20 mA 4 = Thermocouple
2 = 1 to 5 V 5 = RTD

0 = none 4 = Type T t/c 7 = Type B t/c
1 = Square root 5 = Type S t/c 8 = Type N t/c
2 = Type J t/c 6 = Type R t/c 9 = Pt100 RTD
3 = Type K t/c

't/c' = thermocouple

0 = Not connected 3 = Loop 1 remote setpoint (RM)
1 = Loop 1 track input (TK) 4 = Loop 1 setpoint trim (TM)
2 = Not used

0 = Open circuit 4 = Loop 1 setpoint trim (TM)
1 = Loop 1 track input (TK) 5 = Not used
2 = Not used 6 = Loop 2 remote setpoint (RM)
3 = Loop 1 remote setpoint (RM)* 7 = Loop 2 setpoint trim (TM)

* not available with ratio or cascade controllers

 Bit DV DV DC DC DI
 state bits 0 to 3 bits 4 to 7 bits 0 to 3 bits 4 to 7
 0 low i/p low o/p disconnect* disconnect† copy bit
 1 high i/p high o/p connect connect invert bit

*  DV pulled low by hardware  †  DV holds last value
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C3.7  I/O Calibration (List 7) parameters

Table C3.7  List 7 ( I/O calibration) parameters - Tags 192 to 196

C3.8  Incremental control parameters

Table C3.8  Incremental control parameters (Lists 1 and 8)

Tags 230, 232 and 235 to 237

Appendix C §C3.8

 192 CC Calibration channel Read/Write

 193 CR Calibration range Read/Write

 194 ST Calibration step (0 to 101) *
 195 CV Calibration value Read/Write
 196 CalDP Calibration decimal point position (for calibration via comms.) Read only

* Writable only when previous step complete

Tag
Mne-
monic

List 7 parameters
Enable

(w.r.t. to host)

0 = Main board process  input (terminals 13 to 15)
1 = Main board process output (terminals 16 and 17)
2 = Expansion I/O process input (terminals 35 to 37)
3 = Expansion I/O analogue input (terminals 38 and 39)
4 = Expansion I/O analogue output (terminals 40 and 41)

0 = 4 to 20 mA process inputs and outputs
1 = 0 to 20 mA process inputs and outputs
2 = 1 to 5 Volt inputs and outputs
3 = 0 to 10 V inputs and outputs
4 = Thermocouple process inputs
5 = PRT process inputs

 230 TT Motor travel time (0.5 to 1999.9 secs) Read/Write
 232 VO Velocity output demand (-100 to + 100 %) Read/Write
 235 IN Inertia compensation time (0.0 to 20.0 seconds) Read/Write
 236 BL Backlash compensation time (0.0 to 20.0 seconds) Read/Write
 237 Manual_action IManual control of incremental outputs Write only

Tag Mnemonic
Incremental control parameters

(Lists 1 and 8)
Enable

(w.r.t. to host)
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Appendix C §C3.9

 197 LightAll Light all fascia LEDs (1 = LEDs lit for approx 6 secs. then bit resets) Read/Write
 198 Pow_PB Pushbutton states Read Only

 199 SI I/O status word Read Only
   Bit 0 Missed filter
   Bit 1  Extra filter
   Bit 2 Nominal calibration data sumcheck failure
   Bits 3 to 15 unused
 200 R1 Count of I/O missed readings Read Only
 201 R2 Count of I/O bad readings Read Only
 202 R3 Count of digital feedback verification failures Read Only
 203 R4 Count of tasks unable to complete in allotted time Read Only
 204 E0 Error logs stack (youngest error) Read Only
 205 E1 Error logs stack Read Only
 206 E2 Error logs stack Read Only
 207 E3 Error logs stack Read Only
 208 E4 Error logs stack Read Only
 209 E5 Error logs stack Read Only
 210 E6 Error logs stack Read Only
 211 E7 Error logs stack Read Only
 212 E8 Error logs stack Read Only
 213 E9 Error logs stack Read Only
 214 EA Error logs stack Read Only
 215 EB Error logs stack Read Only
 216 EC Error logs stack Read Only
 217 ED Error logs stack Read Only
 218 EE Error logs stack Read Only
 219 EF Error logs stack (oldest error) Read Only
 220 ST Strategy cycle time Read Only

Tag
Mne-
monic

List 9  Diagnostic parameters
Enable

(w.r.t. to host)

Bit
number

0
1
2
3
4
5
6
7

Decimal value
 if bit set

1
2
4
8

16
32
64
128

Push
Button

Down arrow
Up Arrow

SP
M

PAR
A

Alm ack
R

See table below for error messages

 01 Main board DFC failed to communicate at start-up yes no
 02 Main board DFC failed to communicate whilst strategy is running yes yes
 03 Expansion I/O DFC failedto communicate at start-up no no
 04 Expansion I/O DFC failed to communicate whilst strategy is running yes yes
 05 Unrecognised expansion I/O card at start-up no no
 06 Unrecognised expansion I/O card whilst strategy running yes yes
 30 Internal error no no
 31 Internal error yes yes
 32 Internal error no no
 33 Internal error no no
 38 I/O task unable to complete in the allotted time yes yes
 39 User interface task unable to complete in allotted time no no
 3A Control task unable to complete in allotted time no no

Error Nº
(Hex)

Error definition Fatal ?
(causes reset)

Non-volatile
memory saved?

Consult factory

C3.9  Diagnostics (list 9) parameters

Table C3.9a  List 9 (diagnostics) parameters - Tags 199 to 220

Table C3.9b  Error messages for tags 204 to 219
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Appendix D §D2.1

Appendix D:
IMPORTING GSD FILES INTO COMMERCIAL
PROFIBUS CONFIGURATION SOFTWARE

D1 OVERVIEW
In order to configure PROFIBUS networks, GSD files (<name>.GSD) must be imported
into the network configuration tool provided by the vendor of the PROFIBUS Master de-
vice.  It is also often possible to include a supplementary bitmap file which provide an
icon of the unit being configured for use on a graphical representation of the network.

Section D3 below, includes details of how to import GSD files into a number of different
Vendors' Master software.  These examples should give an indication of how GSD files
can be imported into other suppliers' configuration tools.

D2  FINDING FILES ON DISK

D2.1  GSD files and bitmaps
It is assumed that a GSD file has been created using the GSD file editor described in Ap-
pendix A above and that its location on hard or floppy disc drive is known.

Notes:
1. A set of standard GSD files and bitmaps are included on the PROFIBUS sup-

port disk supplied with this manual.  These files are copied into the directory
in which the program is installed, usually C:\EUROPROF.  Unless action is
taken to save GSD files elsewhere, all files created by the GSD File Editor
will also be saved to this directory.

2. A GSD file contains a list of required parameters for a particular type of in-
strument - it does not contain the node address of any individual instrument.
The node address is a part of each instruments own configuration (see section
2.2 above) and in the Master Configuration, that particular node address is as-
sociated with a particular GSD file.  This means that, for example, all tem-
perature controllers can use one GSD file containing parameters suited to
temperature controllers, whilst all pressure controllers use a different GSD
file with a set of parameters related to pressure control.
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Appendix D §D3.1

D2.2  MASTER CONFIGURATION SOFTWARE
In most cases, it will be necessary for the user to determine the location on the hard disk
into which the Master Configuration Software has been installed.  In the examples below,
it is assumed that the default location defined by the installation program of the Master
Software has been used.  If it has been installed into a different directory or drive the user
must modify the procedure accordingly.

D2.2.1  Copying files
It is usually necessary to copy files from one location on the hard disk drive to another, as
a part of the process of importing GSD files.  This can be done using Windows Explorer,
File Manager or MSDOS copy programs.  It may be easier to configure Windows 95 ex-
plorer to display file name extensions in order to locate the required files more easily
(>GSD for GSD files, >BMP for bitmaps).

D3  CONFIGURATION TOOL EXAMPLES

D3.1  Siemens: SINEC SETUP V1.02/COMLDP V1.01
This is a simple network configuration tool provided with Siemens PC master cards such
as the CP5412A2.  There is no graphical representation of the network, so no bitmap
copying is required.

D3.1.1  Importing a GSD file
1. Select 'DP Configuration' from the 'Edit' menu of Sinec Setup.  This runs

the DP configuration program (COML DP).

2. Select 'New' from the 'File' menu, then, from the 'Extras' menu, select
'Update Catalogue (GSD)...' This causes a list of all the DP device names
(Slave names) in the catalogue to be displayed.

3. Use the 'Import GSD' button.

4. Locate the required GSD file in the file dialogue box, and then to click 'OK' to im-
port the selected GSD file.  Once complete, click 'OK' again to finish.

5. Select the device and add it to the network using 'Catalogue Slave' from the
'Insert' menu.  To remove a slave, use the 'Delete Entry' button.

6. Assign a node address by clicking on the node address field on the left hand side of the
'Slave List' and typing a new number in.

Note:  The program does not automatically load any changes made to the GSD
file after it has been imported. If a GSD file is edited (e.g. to add or remove pa-
rameters) then the old file must be deleted using 'Update catalogue' and the new
file imported.
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Appendix D §D3.2

D3.2  Siemens COM PROFIBUS V 3.1
The GSD files used by this program must be located in the GSD subdirectory of the instal-
lation directory C:\COMPB31.  (This is the default directory which is an abbreviation of
COM PROFIBUS version 3.1)

Files can be copied to this directory from the GSD Editor installation directory ( default =
C:\EUROPROF), or can be created there using the 'Save as' option of the editor and select-
ing the \COMPPB31\GSD sub-directory using the dialogue box.  The GSD editor remem-
bers that this is the last sub-directory used, and subsequent files will be loaded from and
saved to it directly, unless told otherwise.

In addition to the GSD files, all bitmap (.bmp) files should be copied from the file editor
or from the support disk to directory COMPB31\BITMAPS .  These will provide a graphi-
cal representation of the instrument after configuration.  This needs to be carried out only
once.

When all the required files are in their correct directories, use of the 'Scan GSD
files' option on the 'File' menu loads the files.

Note: The 'Load GSD file' verifies that a GSD file is present and valid, but
does not import it.

To create the network, use 'File', 'New' and add the devices as described in the pro-
gram documentation.  Devices are added by pressing the 'CONTROL' button, and their
node addresses are assigned at this point.

Note:  The program does not automatically load any changes made to the GSD
file after it has been imported. If a GSD file is edited (e.g. to add or remove pa-
rameters) then the old file must be deleted using 'Update catalogue' and the new
file imported.
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Appendix D §D3.3

D3.3  Hilscher (Synergetic) SYCON Configurator V1 (16 Bit)

The GSD files used by this program must be located in the GSD subdirectory of the instal-
lation directory C:\PROFIBUS\SYCOMDP.  (This is the default directory.)

Files can be copied to this directory from the GSD Editor installation directory ( default =
C:\EUROPROF), or can be created there using the 'Save as' option of the editor and select-
ing the \PROFIBUS\SYCOMDP sub-directory using the dialogue box.  The GSD editor
remembers that this is the last sub-directory used, and subsequent files will be loaded from
and saved to it directly, unless told otherwise.

Bitmaps are not supported so there is no need to import them

Use the 'Add device option on the 'Device data base' menu to locate and import the GSD
file.  If you wish to use a number of different GSD files for the same device type, the pro-
gram requires that you give a unique name to each device in the 'Description' field of the
GSD file editor, so that it can differentiate between the devices on the database.

Note:  The program does not automatically load any changes made to the GSD
file after it has been imported. If a GSD file is edited (e.g. to add or remove pa-
rameters) then the old file must be deleted as follows:

a use the  'Display' option on the 'Device data base' menu to display
the device database, which is a list of the currently loaded GSD file types.

b Click on the required device name, and remove it by using the delete button.

The replacement file is loaded using the 'Add device'  option on the 'Device
data base' menu.
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D3.4  Hilscher (Synergetic) SYCON Configurator
                             V2.4 (32 Bit - Windows 95 and NT only)

The GSD files used by this program must be located in the FieldBus\PROFIBUS\GSD
subdirectory of the installation directory C:\Program Files\Hilscher GmbH\SyCon. (This
is the default directory.)

Files can be copied to this directory from the GSD Editor installation directory ( default =
C:\EUROPROF), or can be created there using the 'Save as' option of the editor and select-
ing the sub-directory using the dialogue box. It should be noted that some elements are ab-
breviated because the editor is a 16-bit application:

\PROGRA~1\HILSCH~1\GMBH\SYCON\FIELDBUS\GSD

 The GSD editor remembers that this is the last sub-directory used, and subsequent files
will be loaded from and saved to it directly, unless told otherwise.

In addition to the GSD files, all bitmap (.bmp) files should be copied from the file editor
or from the support disk to the FieldBus\PROFIBUS\BMP sub-directory of the SyCon in-
stallation directory.  These will provide a graphical representation of the instrument after
configuration.  This needs to be carried out only once.

SyCon scans (imports) all GSD files when it starts up,  so you need only to add the de-
vices to the network and assign node addresses as described in the SyCon documentation

Because the program imports all GSD files at start up, it is necessary only to shut the pro-
gram down and then re-start it to import any newly edited files.
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D3.5  SST (S&S Technologies) PROFIBUS Configurator
                   V0.14 Beta (32 Bit - Windows 95 and NT only)

The GSD files used by this program must be located in the PBX subdirectory of the instal-
lation directory C:\DLINK32\5136-PFB  (this is the default directory.)

Files can be copied to this directory from the GSD Editor installation directory ( default =
C:\EUROPROF), or can be created there using the 'Save as' option of the editor and select-
ing the DLINK32\5136-PFB\PBX sub-directory using the dialogue box.  The GSD editor
remembers that this is the last sub-directory used, and subsequent files will be loaded from
and saved to it directly, unless told otherwise.

Bitmaps are not supported so there is no need to import them

The program scans (imports) all GSD files when it starts up,  you need only to add the de-
vices to the network and assign node addresses as described in the SyCon documentation

Because the program imports all GSD files at start up, it is necessary only to shut the pro-
gram down and then re-start it to import any newly edited files.

D3.6  Softing/Integrated Control Technology PROFIBUS
   DP Configurator (ProfiConf)

The importing of GSD files into this program is carried out as follows:

1. Use the 'Edit DDB path' option in the 'Options' menu.
2. Use the 'Add' button.
3. Use the dialogue box which is displayed to locate the directory containing your GSD

files (C:\EUROPROF is the default name).
4. Exit the program and re-start it. (Once this has been done,  any changes to GSD files

are automatically imported when PROFIBUS starts up.)
5. Add the device to the network by clicking on its name in the 'Model Name' window,

and assigning a node address to it.

Bitmaps are not supported by this program.
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